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About this Guide
This guide provides information about creating user interfaces with Composite
Application Framework (CAF) and OpenUI.

Document Conventions
Convention

Description

Bold

Identiﬁes elements on a screen.

Narrowfont

Identiﬁes service names and locations in the format
folder.subfolder.service , APIs, Java classes, methods, properties.

Italic

Identiﬁes:
Variables for which you must supply values speciﬁc to your own
situation or environment.
New terms the ﬁrst time they occur in the text.
References to other documentation sources.

Monospace
font

Identiﬁes:

{}

Indicates a set of choices from which you must choose one. Type
only the information inside the curly braces. Do not type the { }
symbols.

|

Separates two mutually exclusive choices in a syntax line. Type
one of these choices. Do not type the | symbol.

[]

Indicates one or more options. Type only the information inside
the square brackets. Do not type the [ ] symbols.

...

Indicates that you can type multiple options of the same type.
Type only the information. Do not type the ellipsis (...).

Text you must type in.
Messages displayed by the system.
Program code.
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Online Information and Support
Software AG Documentation Website
You can ﬁnd documentation on the Software AG Documentation website at “hp://
documentation.softwareag.com”. The site requires credentials for Software AG's Product
Support site Empower. If you do not have Empower credentials, you must use the
TECHcommunity website.
Software AG Empower Product Support Website
If you do not yet have an account for Empower, send an email to
“empower@softwareag.com” with your name, company, and company email address
and request an account.
Once you have an account, you can open Support Incidents online via the eService
section of Empower at “hps://empower.softwareag.com/”.
You can ﬁnd product information on the Software AG Empower Product Support
website at “hps://empower.softwareag.com”.
To submit feature/enhancement requests, get information about product availability,
and download products, go to “Products”.
To get information about ﬁxes and to read early warnings, technical papers, and
knowledge base articles, go to the “Knowledge Center”.
If you have any questions, you can ﬁnd a local or toll-free number for your country
in our Global Support Contact Directory at “hps://empower.softwareag.com/
public_directory.asp” and give us a call.
Software AG TECHcommunity
You can ﬁnd documentation and other technical information on the Software AG
TECHcommunity website at “hp://techcommunity.softwareag.com”. You can:
Access product documentation, if you have TECHcommunity credentials. If you do
not, you will need to register and specify "Documentation" as an area of interest.
Access articles, code samples, demos, and tutorials.
Use the online discussion forums, moderated by Software AG professionals, to
ask questions, discuss best practices, and learn how other customers are using
Software AG technology.
Link to external websites that discuss open standards and web technology.
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Data Protection
Software AG products provide functionality with respect to processing of personal data
according to the EU General Data Protection Regulation (GDPR). Where applicable,
appropriate steps are documented in the respective administration documentation.
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About Business Console Gadgets
Business Console gadgets are re-usable components that enable customization and
personalization of business monitoring AppSpaces in Business Console.
Business Console oﬀers built-in gadgets for creating AppSpaces. However, you can
create your own gadgets by using wizards in Designer, deploy these new gadgets to a
My webMethods Server, and re-use these gadgets for customizing Business Console.
When you design a gadget in Designer, you can specify:
Whether or not to use AngularJS framework to create the gadget
User interface and functionality of the gadget
Custom parameters for conﬁguring gadgets in Business Console
JavaScript events for communicating between gadgets
Remote server connections for the gadget
REST invocation method for communicating with remote servers (whether to
use Cross-origin resource sharing (CORS) support on remote servers or Business
Console's proxy REST service)
My webMethods Server on which the gadget must be deployed
You can manage access permissions for a gadget in My webMethods Server. For more
information about assigning permissions, see Administering My webMethods Server.
For information about re-using gadgets and customizing Business Console, see Working
with webMethods Business Console.

Creating a New Business Console Gadget
In the UI Development perspective, you can create gadgets in a gadget application
project, a web application project, or a portlet application project in one of the following
views:
Solutions view
Navigator view
Project Explorer view
After you complete the gadget design, publish the gadget, web, or portlet application
projects to My webMethods Server to make it available in Business Console AppSpaces.
For information about creating and publishing a project, see webMethods CAF and
OpenUI Development Help.
Note:

You need JavaScript knowledge for programming gadgets.
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To create a new gadget
1. Select the UI Development perspective.
2. Select the gadget, web, or portlet application project where you want to create a new
gadget, and start the New Business Console Gadget wizard in one of the following
ways:
For information about the gadget application project, see “ Creating a Gadget
Application Project” on page 17. For information about web application and
portlet application projects, see webMethods CAF and OpenUI Development Help.
In the Solutions view, expand User Interfaces, right-click on the project where you
want to create a new gadget, and select New Business Console Gadget.
In the Navigator view or Project Explorer view, right-click on the project
where you want to create a new gadget, and select New > Other > Software AG > UI
Development > New Business Console Gadget.
3. In the New Business Console Gadget wizard, provide the speciﬁcation for the new
gadget. For information about what values to specify for the new gadget, see “New
Business Console Gadget Wizard” on page 12.
The New Business Console Gadget wizard creates the conﬁguration ﬁles and
deﬁnition ﬁle for the new gadget. For information about the conﬁguration ﬁles and
deﬁnition ﬁle for a gadget, see “Gadget Conﬁguration Files” on page 15 and
“Gadget Deﬁnition File” on page 17.
4. Conﬁgure and customize the gadget.
a. Program the gadget depending on the gadget type by doing one of the following:
To create a gadget without using any pre-deﬁned templates, edit the
custom.js ﬁle.
To create a gadget using the AngularJS framework, edit the controller.js and
custom.js ﬁles.
b. In the Scripts and Styles folders for the gadget, create a script ﬁle and style ﬁle,
respectively.
c. Provide the gadget details on the Gadget Definition Editor tab. To view the Gadget
Definition Editor tab, do one of the following:
In the Solutions view, double-click the gadget.
In the Navigator view or Package Explorer view, double-click
the gadgetDeﬁnition.xml ﬁle corresponding to the gadget in the
web_or_portlet_application/WebContent/WEB-INF/gadgets/
gadgetName_gadgetID folder.
For information about the details to specify, see “Gadget Deﬁnition Editor” on
page 19.
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New Business Console Gadget Wizard
General Gadget Specification
In the New Business Console Gadget wizard, provide the project and gadget details as
described in the table below:
Field / Control

Description

Project

Speciﬁes the web or portlet application
project selected for gadget creation.

Gadget Type

Specify one of the following type:
AngularJS if you want to use
AngularJS framework for the new
gadget . For example, the AngularJS
framework will contain a template for
invoking REST services.
Default with empty stubs if you want to
design the new gadget from scratch
without using any pre-deﬁned
templates.

Gadget Root Directory Name

(Optional) Specify a name for the
folder in which the new gadget should
be stored under project’s WebContent
node.
If you do not specify a folder name,
the new gadget will be stored directly
under project’s WebContent node.

Gadget Name

Specify a name for the new gadget. The
gadget name:
Must have minimum 5 characters and
maximum 50 characters.
Should not have any special
characters.
Should be a single word.

Gadget Title

Working with Business Console Gadgets Help Version 10.3
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Field / Control

Description

Preview Image

Click Browse and select an icon in .png
or .jpg format for the gadget. The
image size should not be more than
50KB, and the preferred size of the
image is 70 X 70.

Settings Title

Specify a name for the gadget seing
dialog.

Description

Provide a description for the new
gadget.

Gadget ID

Speciﬁes the auto-generated ID for the
new gadget. This ﬁeld is not editable.

Gadget Group Name

Select one of the options for the gadget
group name:
Use project name if you want to use
the project name as the gadget group
name.
Use custom name if you want to enter
the name for the gadget group in the
input ﬁeld.
The group name provided here will
be used to categorize gadgets in the
Add New Gadget dialog in Business
Console.

Finish

Click if you selected Default with empty
stubs as the gadget type.
A new gadget will be created under
the project selected for the gadget.

Next

Working with Business Console Gadgets Help Version 10.3
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AngularJS Gadget Specification
The table below describes what you can specify when you create a new AngularJS
gadget.
Element

Description

Hosts

For each remote server that you want to
conﬁgure with the gadget , specify the
following host details:
Name Type the alias name of the server.
Host name Type the host name of the server.
Port Type the port used by the server.
Server type Select one of the server types
from the list.
AgileApps Cloud (Uses SAML 2.0
authentication)
Integration Server (Uses SAML 2.0
authentication)
My webMethods Server (Uses SAML 2.0
authentication)
Others (Does not use SAML 2.0
authentication)
Secure Select this option if you want to use
HTTPS protocol for secure communication.

JavaScript Event Bus

Select this option if you want to specify
publish and subscribe events for the gadget.
To deﬁne publish events
1. Click Add next to Publish.
2. Specify the publish event name.
3. (Optional) Provide the payload for the
publish event in a text window. Specify a
payload only if the event has to send a ﬁxed
payload each time the event is ﬁred.
To deﬁne subscribe events
1. Click Add next to Subscribe.
2. Specify the subscribe event name.
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Element

Description
Select the Use Cross-origin resource sharing
(CORS) support on host servers option if you
want the gadget to communicate with host
servers that support CORS.

REST Invocation

Select the Use Business Console proxy service
option if you want the gadget to use
Business Console's inbuilt Proxy REST
service to communicate with the host
servers.
Finish

Click this option to create a new gadget as
speciﬁed in the wizard.

Gadget Configuration Files
You can ﬁnd the folders and ﬁles that the New Business Console Gadget wizard creates
in the following locations:
In the Solutions view, the folders and ﬁles are in the User
Interfaces/<gadget_folder_if_provided> /gadget_name folder.
In the Navigator view or Package Explorer view, the folders and ﬁles are in the
web_or_portlet_application /WebContent/<gadget_folder_if_provided> /gadget_name
folder.
The following table describes the folders and ﬁles.
Folder

Files

Description

Images

gadget_icon_image.png

This image ﬁle will be
used as the icon for the
new gadget.

or
gadget_icon_image.jpg
Scripts

conﬁg.js

This ﬁle will contain the
gadget conﬁguration
details.
Do not edit this autogenerated ﬁle.

controller.js
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Folder

Files

Description
speciﬁes how the gadget
will work.
You need to know
JavaScript and
AngularJS to edit this
ﬁle and program the
gadget.

custom.js

Optionally, you
can use this ﬁle to
programmatically
customize the gadget.

Styles

style .scss

This folder will contain
the default style sheet
for the gadget. You can
add your own style
sheets (.scss ﬁles) to this
folder.

Views

seings.xhtml

This ﬁle will be empty
initially.
In this ﬁle, you
can build a custom
form to capture the
values of the custom
parameters speciﬁed
when the gadget is
conﬁgured in a Business
Console AppSpace.
The controller for an
AngularJS gadget
decides the business
logic based on the
values it receives from
the custom form.
For non AngularJS
applications (for
example JQuery), you
can use selectors to
directly capture the
form values and then
apply the business logic.
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Folder

Files

Description

view.xhtml

You can edit this ﬁle and
specify how the gadget
should be displayed
on the web. For gadget
of type AngularJS ,
each view is tied to its
respective controller.
Controller decides the
content for display.

Gadget Definition File
In the Navigator view or Package Explorer view, the gadget deﬁnition ﬁle is listed in the
web_or_portlet_application /WebContent/WEB-INF/gadgets/gadgetName_gadgetID folder.
Folder

Files

Description

gadgetName_gadgetID

gadgetDeﬁnition.xml

This ﬁle will contain
gadget details such as
the location of the ﬁles
pertaining to gadget
styles, scripts, and runtime parameters. Use
the gadget deﬁnition
editor to edit the gadget
deﬁnitions. See “Gadget
Deﬁnition Editor” on
page 19 .

Creating a Gadget Application Project
You can create a gadget application project in the UI Development perspective of
Designer. A gadget application project is similar to a web application project. After
creating a gadget application project, you can create and conﬁgure one or more gadgets
within the project.
When you create a gadget application project, the default application server is My
webMethods Server.
To create a project
1. In the UI Development perspective, select File > New > Other > SoftwareAG> UI
Development > Gadget Application Project.
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The New Gadget Application Project wizard appears.
2. In the Project Name ﬁeld, type a name for the project.
Names cannot contain spaces or any of the following characters:
asterisk (*)
Pipe (|)
Back slash (\)
Forward slash (/)
Colon (:)
Double quotes (")
Less than (<)
Greater than (>)
Period (.)
Question mark (?)
As a best practice, specify short names even though names can use up to 255
characters.
3. In the Target Runtime list, select a server type.
My webMethods Server is the default server.
4. In the Dynamic web module version list, either retain the default value for the API
version or select a version.
5. In the Configuration list, select the Gadget Web Application option.
6. (Optional) In the Working sets area, select the Add Project to working sets check box, and
then click Select to choose a working set for the project.
7. In the Initial Project Contents area, select one of the following in the Project Templates
list:
Empty Project
Starter Web Application
Both options create minimum folders and resources that are required for the project.
8. Click Next to navigate to the Web Module seings.
9. Select the Generate web.xml deployment descriptor check box.
10. Click Finish.
The WebContent\WEB-INF\web.xml ﬁle for the project is created. You can add or
modify security roles in the web.xml ﬁle. For information about adding or modifying
security roles, see webMethods CAF and OpenUI Development Help.
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You can view and work with the new project in the Solutions view, the Navigator
view, or the Project Explorer view of Designer.

Gadget Definition Editor
You can open the gadget deﬁnition editor in one of the following ways:
In the Solutions view, double-click a gadget.
In the Navigator view or Package Explorer view, double-click the
gadgetDeﬁnition.xml ﬁle corresponding to a gadget in the web_or_portlet_application /
WebContent/WEB-INF/gadgets/gadgetName_gadgetID folder.
The table below describes the various sections in the Gadget Definition Editor tab. For
a description of gadget elements, see “New Business Console Gadget Wizard” on
page 12.
Section

Description

General

Expand to edit the gadget properties such as gadget
title, description, seings title, and group name.

Scripts and styles

Expand to provide the scripts (.js ﬁles) and styles
(.scss) ﬁles to be used by the gadget.
If you want to use external scripts such as the
scripts delivered through a content delivery
network (CDN), save the script ﬁle under /
WebContent/<gadget_folder_if_provided>/gadget_name /
Scripts folder, and then provide a relative link to the
script ﬁle here. The same applies when you use an
external style ﬁle.
Do not import a script ﬁle directly in the view.xhtml
ﬁle.

Parameters

Expand to provide the name and value for the custom
properties of the gadget.
It is optional to provide values for the properties.
The values can be provided at runtime by using the
seings.xhtml ﬁle.
Parameter name must be unique within a gadget.

Hosts

Expand to provide the details for each server that you
want to conﬁgure with the gadget.
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Section

Description
Host name must be unique within a gadget.

Publish events

Expand to provide the publish events for the gadget.
Optionally, you can provide the payload for the
publish event. This is applicable only to gadgets of
type AngularJS.

Subscribe events

Expand to provide the subscribe events for the
gadget. This is applicable only to gadgets of type
AngularJS.

Dependencies

Expand to provide the dependent modules to be
injected to the gadget framework.
This is applicable only for AngularJS based gadgets.
Independent AngularJS module(s) created in a gadget
can be shared with another gadget.
Make sure you add the dependencies only after
the dependent modules are created in gadgets and
deployed to My webMethods Server.
Dependency name must be unique within a gadget.

Previewing a Gadget in Designer
Prior to previewing a gadget, you must specify My webMethods Server as the runtime
application server.
To preview a gadget
1. In the Solutions view, right-click the gadget.
2. Select Run on Server to publish the gadget.
After publishing, the preview appears in your web browser. You can use the URL
to view the gadget directly in the web browser at a later time. For more information
about viewing a gadget directly in a web browser, see “Viewing a Gadget in a Web
Browser” on page 21.
If you have not speciﬁed My webMethods Server as the runtime application server,
the Run on Server wizard appears. You can specify My webMethods Server as the
runtime application server in the wizard.
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Viewing a Gadget in a Web Browser
You can directly view a gadget in a web browser.
To view a gadget in a web browser
1. Specify the URL of the gadget in the following format:
http://host:port/business.console.gadgets#/projectName/gadgetName

where:
host is the host name of My webMethods Server.
port is the port number used by My webMethods Server.
projectName is the name of the web or portlet application project in which the

gadget is deﬁned.

gadgetName is the name of the gadget.

You can also check the format in the Gadget URL ﬁeld of the gadget deﬁnition editor.
For more information about the gadget deﬁnition editor, see “Gadget Deﬁnition
Editor” on page 19.
2. View the gadget in your web browser.
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Importing a Gradle or Apache Maven Based Web Project to
Create Gadgets
You can import a Gradle or Apache Maven based web project into Designer to create
gadgets. After importing, the Gradle or Apache Maven based web project must be
modiﬁed prior to creating gadgets.
To import and modify a Gradle or Apache Maven based web project
1. In Designer, click File > Import > General > Existing Projects into Workspace, and then click
Next.
2. In the Import dialog box, perform one of the following:
In Select root directory, click Browse to choose the directory location of your Gradle
or Apache Maven based web project.
In Select archive file, click Browse to select a zip ﬁle of your Gradle or Apache
Maven based web project.
3. Click Finish.
The Project Explorer and Navigator views display the imported project.
4. To modify the project, perform the following:
a. Right-click the project and click Properties.
The Properties dialog box for the project appears.
b. Click Project Facets and select Convert to faceted form.
c. In the Configuration drop-down list, select CAF Web Application.
d. Click the Runtimes tab and select the My webMethods Server runtime
environment.
If a runtime environment is not listed, click New to add the My webMethods
Server runtime environment.
e. Click Further configuration required.
f.

In the Content directory ﬁeld, type the location of the WEB-INF parent folder. For
example, src/main/webapp.

g. Click Next and select CAF libraries in the Type drop-down list, and then click OK.
h. In the Properties dialog box, click Apply, and then click OK.
i.

In the Project Explorer or Navigator view, right-click the project and click CAF
tools > Repair CAF Project.

You can now create gadgets in the project. For information about creating new
gadgets, see “Creating a New Business Console Gadget” on page 10.
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Creating Gadget User Interfaces for a REST Resource
You can use both REST and REST V2 resource descriptors to generate custom
webMethods Business Console user interfaces, and add those user interfaces to new or
existing gadgets.
The high-level steps for creating user interfaces based on REST API Descriptors are as
follows:
1. Create a REST or REST V2 resource and generate a REST API descriptor for that
resource, using the Package Navigation section on the UI Development perspective
in Designer. For more information about REST resource, REST V2 resource, and
REST API descriptors, see webMethods Service Development Help.
2. Create a CAF web application project, and add a Business Console gadget to that
project.
3. Conﬁgure the input and output mapping of REST resources to the Business Console
user interface elements, using the REST UI Creation Wizard in the UI Development
perspective.
4. Conﬁgure the gadget. For more information, see Developing Gadgets for webMethods
Business Console.
5. Deploy your project to My webMethods Server and display the gadget in an
AppSpace in Business Console.
To create a user interface for a REST resource
1. Create a web application project.
For more information about creating a web application project, see webMethods CAF
and OpenUI Development Help.
2. In the Solutions view, right-click the web application project and select Business
Console Gadgets > New Business Console Gadget.
3. Conﬁgure your gadget as described in “New Business Console Gadget Wizard” on
page 12.
4. In the Solutions view, double-click to open the view.xhtml ﬁle for your gadget in the
view editor.
5. Double-click the REST API descriptor and select the REST Resources tab, and ensure
that the parameters for REST operations such as PUT, GET, and others are correctly
conﬁgured.
All parameters must be set as QUERY for the GET operation because it can send
parameters only through a query string. Similarly, POST and PUT operation
parameters must be either QUERY or FORMDATA.
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Note:

If you select the Get Operation on Load option in the Pagination and Loading
Inputs Conﬁguration page of the REST UI Creation Wizard, a GET
operation with same parameters precedes each PUT operation. In this case,
ensure that PUT parameters are set to QUERY because the corresponding
GET operation can use only QUERY parameters.

6. Drag and drop the required REST API Descriptor to the Design Page of the view
editor.
The REST UI Creation Wizard appears.
7. On the Project Selection page, click Next.
Note:

You can edit the Swagger URL ﬁeld when you start the wizard using the
New > Other > Software AG > UI Development > New REST UI menu. Specify a
publicly available HTTP URL, or a local ﬁle path in the Swagger URL ﬁeld.

8. On the REST Resources Selection page, specify the following and click Next:
The REST resources and operations for which you want to create user interface
controls. You can select only one operation at a time on the REST Resources
Selection page.
Whether to use Cross-origin resource sharing (CORS) support on host servers, or
the Business Console proxy REST service as the REST invocation method.
Whether to use a global or local URL. To use a global URL, you must specify an
alias, and conﬁgure the global server seings for gadgets in My webMethods
Server. In case of a local URL, the URL in the Swagger metadata is used for
accessing the REST resources.
Whether to use Integration Server or other external servers. If you use
other external servers, select Basic in the Select AuthType box, and enter the
authentication password and user name. Additionally, you can select None for no
authentication.
9. On the Field Conﬁguration page, conﬁgure the form in which the Composite
Application Framework can generate user interface controls for the selected REST
resources as follows:
Field/Table

Description

Form Name

The name of the form to display in Business
Console.

Input and Output
Parameters

For each user interface control in the table,
conﬁgure the following ﬁelds:
Name. Select to specify whether to display the
control in Business Console.

Working with Business Console Gadgets Help Version 10.3

26

M

Odd Header
Working with Business Console Gadgets

Field/Table

Description
Display Label. Click to modify the text displayed
on the ﬁeld label in Business Console.
Type. You can set the type for String Arrays as
either String Array or String Table.
Mandatory (only for input parameters). Select to
specify whether a form control is required. The
ﬁeld appears as a mandatory ﬁeld on the user
interface.
Validation (only for output parameters). The
validation type to apply to the control. This
value is populated automatically. The options
are Text, E-mail, Alphanumeric, and Numeric.
UI Control. By default, the framework generates
an appropriate user interface control type for
each REST parameter. For Ref type parameters,
you can select the Tab-Selected option to display
the parameter as a selected tab on the form.
If you select the Tab-Selected option for a Ref
type parameter, other Ref type parameters at the
same level on the Field Conﬁguration page are
grouped and displayed as tabs on the form, but
they are not selected by default.
Default Value. Initial value of Text and Numeric
ﬁelds, String Array, and Numeric Array when
the page is loaded.
These ﬁelds are only for Table and Array type
values:
SortBy. Parameter name to use for sorting (if
REST service supports sorting).
SortOrder. Parameter name to use for sorting
order (if REST service supports sorting order).
DefaultSortColumn. Select the default column to
use for sorting.
DeafultSortOrder. Select either Ascending or
Descending in the list.

Select Column Count
for Input and Output
Parameters

Select the number of columns in which Business
Console displays the generated form. The options
are: One, Two, Three, Four, and Six.
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10. On the Pagination and Loading Inputs Conﬁguration page, conﬁgure the pagination
options.
Select the parameter you want to use for each of the available pagination options.
Field

Description

Name

Select the parameter for which to apply
pagination.

Type

You cannot modify the data type of the control.

Page Number

Select the parameter for number of pages to
display in the Business Console gadget.

Page Size

Select the parameter for number of entries per
page.

Start Index

Select the parameter for start index.

End Index

Select the parameter for end index.

Total Records

Total number of records to display.

11. If you have selected the PUT operation in the REST Resources Selection page, select
how to load the input parameters. You can select one of the following:
Field

Description

None

No action is performed prior to the PUT operation.

Gadget Configuration
Parameter

Specify one or more gadget conﬁguration
parameters and map them to input parameters.

Gadget Event

Specify one or more gadget events and map their
response to input parameters.

Get Operation on Load

A GET operation with same parameters as the PUT
operation precedes the PUT operation.

12. (Optional) Click Browse and save all seings in the REST UI Creation Wizard as a
JSON ﬁle. This action enables you to load the wizard with the same seings later. To
load the wizard using a JSON ﬁle, do the following:
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a. Go to New > Other > Software AG > UI Development > New REST UI, and click Next.
b. Select Import metadata, and then click Browse to select the JSON ﬁle.
c. Click Next.
13. Click Finish.
After Designer generates the user interface, you can conﬁgure it further, deploy it to
My webMethods Server, and use it in Business Console. For more information about
gadget development, see Developing Gadgets for webMethods Business Console. For more
information about working with gadgets at runtime, see Working with webMethods
Business Console.

Creating a webMethods AgileApps Cloud Form Gadget
You can import an AgileApps Cloud form in Designer and create a gadget based on the
form.
To create an AgileApps Cloud form gadget
1. Create a portlet or web application project.
For more information about creating a portlet or web application project, see
webMethods CAF and OpenUI Development Help.
2. In the Solutions view, right-click the portlet or web application project and select
Business Console Gadgets > Generate AgileApps Form Gadget.
3. Connect to AgileApps Cloud by specifying values for the following ﬁelds:
Field

Description

AgileApps Host

The name of the AgileApps Cloud server.

User ID

The user ID to log into the AgileApps Cloud server
host.

Password

The password for the AgileApps Cloud user
account.

4. Click Next.
5. Select an AgileApps Cloud form to import by specifying values for the following
ﬁelds:
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Field

Description

Application

Select an AgileApps Cloud application.

Objects

Select an object associated with the application.

Select a Form to
import

Select one or more forms associated with the object
for which you want to create gadgets.

6. Click Finish.
Designer creates one or more gadgets that you can conﬁgure further. For more
information about programming gadgets, see Developing Gadgets for webMethods Business
Console.
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